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CE Mark

The CE marking applied to this product symbolises Rank Xerox’s declaration of conformity with the following applicable directives of the European Union as of 
the dates indicated.

January 1, 1996—Council Directive 70/80/CCO amended by Council Directive 93/68/EEO. Approximation of the laws of the member states related to low 
voltage equipment.

January 1, 1996—Council Directive 59/336/EEC. Approximation of the laws of the member states related to electromagnetic compatibility.

A full declaration defining the relevant directives and referenced standards can be obtained from your Rank Xerox representative.

WARNING: In order to allow this equipment to operate in proximity to industrial, scientific, and Medical (ISM) equipment, the external radiation from 
ISM equipment may have to be limited or special migration measures taken.

FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

Class B Declaration of Conformity

This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy 
and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. 

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded 
cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the 
approval of manufacturer could void the user’s authority to operate this equipment.

Industry Canada Class B Notice

This Class B digital apparatus meets all the requirements of the Canadian Interference-Causing Equipment Regulations.

Avis de Conformation Classe B de l’Industrie Canada 

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Certificate by Manufacturer/Importer

This is to certify that the FC07 is shielded against radio interference in accordance with the provisions of VFG 243/1991. The German Postal Services have been 
advised that this device is being put on the market and that they have been given the right to inspect the series for compliance with the regulations.
Electronics for Imaging, Inc.

Bescheinigung des Herstellers/Importeurs

Heirmit wird bescheinigt, dass der FC07 im Uebereinstimmung mit den Bestimmungen der VFG 243/1991 Funk-Entstort ist. Der Deutschen Bundespost wurde 
das Inverkehrbringen dieses Geraetes angezeigt und die Berechtigung zur Ueberpruefung der Serie auf Einhaltung der Bestimmungen eingeraumt.
Electronics for Imaging, Inc.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.



           
Dieses Geraet wurde einzeln sowohl als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funk-entstoerbestimmungen 
geprueft. Es ist jedoch moeglich, dass die Funk-enstoerbestimmungen unter unguenstigen Umstaenden bei anderen Geraetekombinationen nicht eingehalten 
werden. Fuer die Einhaltung der Funk-entstoerbestimmungen seigner gesamten Anlage, in der dieses Geraet betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Einhaltung mit betreffenden Bestimmungen kommt darauf an, dass geschirmte Ausfuhrungen gebraucht werden. Fuer die beschaffung richtiger Ausfuhrungen 
ist der Betreiber verantwortlich.

Software License Agreement

Before using the Software, please carefully read the following terms and conditions. BY USING THIS SOFTWARE, YOU SIGNIFY THAT YOU HAVE 
ACCEPTED THE TERMS OF THIS AGREEMENT.  If you cannot or do not accept these terms, you may return the entire package within ten (10) days to 
the Distributor or Dealer from which you obtained them for a full refund.

Electronics for Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included 
with the DocuColor 40 CP you have purchased, including without limitation the PostScript® software provided by Adobe Systems Incorporated.

You may:

a. use the Software solely for your own customary business purposes and solely with DocuColor 40 CP;

b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with DocuColor 40 CP in a special encrypted format 
(“Coded Font Programs”) to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols (“Typefaces”) solely for your 
own customary business purposes on the display window of the DocuColor 40 CP or monitor used with DocuColor 40 CP;

c. use the trademarks used by Electronics for Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to DocuColor 40 CP provided the transferee agrees to be 
bound by all of the terms and conditions of this Agreement.

You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600720 dots per inch or greater, or to generate fonts or typefaces 
for use other than with DocuColor 40 CP;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as 
necessary for use with the DocuColor 40 CP unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to 
be made, any copies of that certain portion of the Software which has been included on the DocuColor 40 CP hard disk drive. You may not copy the 
documentation; 

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

Proprietary Rights

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics for Imaging 
and its suppliers and that title and other intellectual property rights therein remain with Electronics for Imaging and its suppliers. Except as stated above, this 
Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or 
licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. You may not adapt or use any trademark or 
trade name which is likely to be similar to or confusing with that of Electronics for Imaging or any of its suppliers or take any other action which impairs or reduces 
the trademark rights of Electronics for Imaging or its suppliers. The trademarks may only be used to identify printed output produced by the Coded Font 
Programs. At the reasonable request of Electronics for Imaging, you must supply samples of any Typeface identified with a trademark.

Confidentiality

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need 
to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

Remedies

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic 
termination of this license and will make available to Electronics for Imaging other legal remedies.



            
Limited Warranty And Disclaimer

Electronics for Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without 
significant errors that make it unusable. Electronics for Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning 
DocuColor 40 CP to Electronics for Imaging or an authorized dealer) will be, at Electronics for Imaging’s option, to use reasonable commercial efforts to attempt 
to correct or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. 
Some states do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.

Except for the above express limited warranty, Electronics for Imaging makes and you receive no warranties or conditions on the Products, express, implied, or 
statutory, and Electronics for Imaging specifically disclaims any implied warranty or condition of merchantability or fitness for a particular purpose.

For warranty service, please contact your authorized service/support center.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES 
OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION 
OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics for Imaging does not warrant that 
the operation of the software will be uninterrupted or error free or that the Software will meet your specific requirements.

Limitation Of Liability

IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST 
PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF 
THE SOFTWARE, CODED FONT PROGRAMS OR ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE UNIT REFLECTS THIS ALLOCATION OF RISK. 
BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government 
licenses. Your failure to comply with this provision is a material breach of this Agreement.

Government Use

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted 
Right Clause at 48 CFR 52.227-19, as applicable.

Third Party Beneficiary

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA  95110-2704 (“Adobe”) is a third-
party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the 
Typefaces and the Trademarks licensed hereby.  Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics 
for Imaging.

General

This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font 
Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics for Imaging, Inc., Attn: Licensing Dept. or see Electronics for Imaging’s web site 
at www.efi.com.

Electronics for Imaging, Inc.
2855 Campus Drive
San Mateo, CA 94403
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xi About this manual

     
The DocuColor 40 CP Color Server enables you to use your color copier as a 
networked printer. You can use the DocuColor 40 CP to print final documents or to 
proof jobs you will later print on an offset press. You send a print job to the 
DocuColor 40 CP as you would to any other printer—you select it from the Microsoft 
Windows Printers dialog box or Apple Mac OS Chooser, and then print from within 
any application.

About this manual
This manual is intended for those remote users who send jobs via the network or via a 
direct parallel port connection between the DocuColor 40 CP and a Windows 
computer. It covers the following topics:

• Printing from a Windows computer

• Printing from a Mac OS computer

• Printing from UNIX

• Downloading files and fonts using Downloader

• Monitoring jobs and accessing information using WebTools 

• Specifying and overriding job settings, examples of the printer fonts installed on the 
DocuColor 40 CP, and troubleshooting information.

Preface
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About the documentation
This manual is part of a set of DocuColor 40 CP documentation that includes the 
following manuals for users and system administrators:

• The Configuration Guide explains basic configuration and administration of the 
DocuColor 40 CP for the supported platforms and network environments. It also 
includes guidelines for setting up UNIX, Windows NT, and Novell NetWare servers 
to provide Adobe PostScript printing services to clients.

• Getting Started describes how to install software to enable users to print to the 
DocuColor 40 CP. Specifically, it describes installation of PostScript™ printer 
drivers, printer description files, and other user software provided on the 
DocuColor 40 CP User Software CD. It also explains how to connect each user to 
the network.

• The Printing Guide describes the printing features of the DocuColor 40 CP for users 
who send jobs via remote workstations on the network or via a direct parallel port 
connection.

• The Color Guide provides an introduction to the basics of color theory and printing 
to a DocuColor 40 CP Color Server. It also includes practical color printing tips and 
application notes that explain how to print to the DocuColor 40 CP from popular 
Windows and Mac OS applications.

• The Job Management Guide explains the functions of the DocuColor 40 CP utilities, 
and how they are used to manage jobs and maintain color quality. This book is 
intended for an operator or administrator, or a user with the necessary access 
privileges, who needs to monitor and manage job flow, perform color calibration, 
and troubleshoot problems that may arise. 

• Release Notes provide last-minute product information and workarounds for some of 
the problems you may encounter.

How the DocuColor 40 CP works
The DocuColor 40 CP receives files from computers on the network, processes (RIPs) 
those files, and then sends them to the copier’s print engine for printing. Even with the 
DocuColor 40 CP installed, you can still use the copier to make copies. 

When printing from an application, your Windows or Mac OS computer 
communicates with the DocuColor 40 CP by means of a PostScript printer driver and 
a PostScript printer description file (PPD). 
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About PostScript printer drivers and PPDs
A PostScript printer driver is an application that manages printing communication 
between your application software and the printer. It interprets the instructions 
generated by the application software, merges those instructions with printer-specific 
PPD options you specify (see below), and translates all that information into 
PostScript, a language the printer understands. In other words, the printer driver writes 
a PostScript file based on your original file and the options you set from the Print 
dialog box.

A PPD file contains information about a particular device’s features and capabilities 
(for example, what paper sizes and media types are supported). The PostScript printer 
driver reads the information in the PPD file and presents that information to you in 
the form of options you can choose from the Print dialog box. The PPD for the 
DocuColor 40 CP includes information about the features of both the copier and the 
DocuColor 40 CP Color Server. 

For information on the PPD options for your DocuColor 40 CP, see Appendix A, 
"Print Options."

Supported paper sizes and resolutions
You can print all page sizes supported by the DocuColor 40 in Contone mode at 
400 dpi in Full Color or Grayscale. Note that you can print on thick paper and 
transparencies only from the bypass tray. See the Xerox Materials Usage Guide for 
complete information about the page sizes supported.

Before you begin
Before using the DocuColor 40 CP, follow these steps:

1. Confirm that the system administrator has completed Setup as described in the 
Configuration Guide.

2. Find out what printer defaults the administrator specified in Setup. 

These default settings can affect the results of your print jobs. Check with your 
administrator or operator for information on these default settings.

3. Confirm that the user software is installed correctly on your workstation, as described 
in Getting Started.
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4. Consult the Color Guide for information on print options and application features that 
affect color output.

5. Find out how your workstation is configured for printing on the network.

If your site has an operator who controls all printing, you may have access to the Hold 
queue only. In this case, all jobs you send are spooled to the DocuColor 40 CP and 
held until the operator sends them to their next stage of processing. 

You may also have access to the Print queue. If you send jobs to this queue, jobs spool 
to the DocuColor 40 CP and proceed to RIP and print according to your job 
settings—unless someone (you, or an operator, for example) intervenes.

Lastly, you may have access to the Direct connection, which sends jobs straight to the 
server without spooling.

6. Find out whether the DocuColor 40 CP is set up to use WebTools and what your access 
privileges are.

The administrator may or may not have enabled access to the server via the Internet 
(or an intranet).
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1-1 Printing from applications

                 
This chapter describes how to print to the DocuColor 40 CP from Windows 95, 
Windows 3.1x, and Windows NT 4.0 computers.

You can print from a networked Windows computer, from a Windows computer using 
Windows (WINS) printing, or from a Windows computer connected to the parallel 
port on the DocuColor 40 CP. If you plan to print files at another location, follow the 
procedures described in “Saving files to print at a remote location” on page 1-12.

Another way to print from a Windows 95 or Windows NT 4.0 computer is to 
download PostScript, Encapsulated PostScript (EPS), or Portable Document Format 
(PDF) files using Downloader. Basic instructions are provided at the end of this 
chapter; for details on using Downloader, see Chapter 4.

NOTE: For information on setting up the Windows environment for printing with 
Windows servers connected to the DocuColor 40 CP, see the Configuration Guide. For 
information on how to connect to the DocuColor 40 CP over the network, install 
printer drivers, and install Downloader, see Getting Started.

Printing from applications
Once you have installed the printer driver and set it to the proper port as described in 
Getting Started, you can print directly from most Windows applications. Simply 
choose the Print command from within your application.

To achieve the best printing results from specific applications, see the Color Guide. 

Setting options and printing with Windows 95
To print from Windows 95, use the Adobe PostScript Printer Driver for Windows 
version 4.2.x included with the DocuColor 40 CP user software.

Once you have installed the Adobe PostScript printer driver and DocuColor 40 CP 
PostScript Printer Description file (PPD), you can specify print settings. You can also 
change some of these settings for a particular job from within your application when 
you send it to the DocuColor 40 CP. Before printing, make sure the correct print 
options are set.

Chapter 1:
Printing from 
Windows 
Computers 
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1-2 Printing from Windows Computers

                                       
TO SET PRINT OPTIONS AND PRINT FROM WINDOWS 95 WITH THE ADOBE 
PS PRINTER DRIVER:

1. Click the Start button, point to Settings, and click Printers.

2. Select the icon for the DocuColor 40 CP and choose Properties from the File menu.

3. Click the Paper tab.

4. Specify the appropriate settings for your print job.

In the Paper size area, specify the page size for your job.

From the Paper Source pop-up menu, choose the paper tray for the job. 

To specify a Media Type, click More Options. Choose from the Paper type pop-up 
menu and then click OK. 

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 
type than that of the job you are sending, the DocuColor 40 CP displays an error 
message and the job will not print. You should then load the correct paper in the 
selected tray or cancel the job.

See Appendix A for information on these print options.



 

11-3 Printing from applications
5. To use a standard paper size, make your selection and skip to step 10. 
To define a custom paper size, scroll the Paper size bar to the right and select one of 
the three Custom p+ paper sizes. 

6. Click Custom to specify the dimensions of the custom paper size. 

The minimum and maximum dimensions allowed by the printer driver are indicated 
inside brackets. You are notified if you enter an invalid dimension. 

You can also give the custom paper size a name. 

7. Set custom paper size dimensions and click OK.

8. Click Unprintable Area and enter margin values for the custom paper size.

The minimum and maximum values allowed by the printer driver are indicated inside 
brackets. You are notified if you enter an invalid entry. 

9. Click OK.
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10. Click the Options tab.

11. Click through Job, Color1, Color2, and so on, and specify the appropriate settings for 
your print job.

These print options are specific to the DocuColor 40 CP and the DocuColor 40. They 
override settings in DocuColor 40 CP Printer Setup; the settings can also be changed 
in the Override Print Settings dialog box with WebSpooler. For information about 
these options and overrides, see Appendix A, “Print Options.”

If you choose Printer’s default, the job prints according to the setting entered during 
Setup.

Some PPD options are ones that could also be set from an application (for example, 
Reverse Order printing or Collation). In these cases, use the PPD option to perform 
the function, rather than setting it from the application. The application may not set 
up the file properly for printing and may also take longer to process.
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12. If you want to make the new settings your default settings, click Apply.

13. Click OK.

14. Choose Print in your application.

15. Click OK.

16. Enter text messages in the Notes 1 and Notes 2 areas. 

Enter user and job identification information for accounting purposes, or whatever 
information is required at your site. 

The notes you enter in these areas can be viewed from the WebSpooler, and also 
appear in the Job Log. They cannot be edited or erased by the operator. 

17. Enter instructions to the operator about the job in the Instructions area.

These instructions can be viewed from the WebSpooler, but do not appear in the Job 
Log. They can be edited by the operator.

18. Click OK.
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Saving and loading print option settings

Print option settings can be saved to a settings file on your hard disk. Saving a settings 
file enables you to easily load specifically configured settings for a particular job.

TO SAVE PRINT OPTION SETTINGS:

1. After specifying settings for print options in the Options tab, click Save Settings.

2. Name the settings file and browse to a location on your hard disk where you want to 
save the file.

3. Click OK.

The settings file is saved to the location you specified.

TO LOAD PRINT OPTION SETTINGS:

1. From the Options tab, click Load Settings.

2. Browse to the settings file.

3. Select the settings file from the list and click OK.

The print option settings in the Options tab are automatically configured with the 
saved settings.

Setting options and printing from Windows 3.1x
To print from Windows 3.1x, use the Adobe PostScript Printer Driver included with 
the DocuColor 40 CP user software. 

Once you have installed the Adobe PostScript printer driver and DocuColor 40 CP 
PostScript Printer Description file (PPD), you can specify print settings. You can also 
change some of these settings for a particular job from within your application when 
you send it to the DocuColor 40 CP. Before printing, make sure that the correct print 
options are set.
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TO SET PRINT OPTIONS AND PRINT FROM WINDOWS 3.1X WITH THE 
ADOBE PS PRINTER DRIVER:

1. In the Main window, double-click the Control Panel icon.

2. Double-click the Printers icon.

3. In the Printers window, select the DocuColor 40 CP in the Installed Printers box and 
click the Setup button. 

4. Click the Paper tab.

5. Specify the appropriate settings for your print job.

From the Paper Source pop-up menu, choose the paper tray for the job. The Paper 
Source selection is valid for the current job only.

In the Paper Size pop-up menu, specify the page size for the job.

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 
type than that of the job you are sending, the DocuColor 40 CP displays an error 
message and the job will not print. You should then load the correct paper in the 
selected tray or cancel the job.



11-8 Printing from Windows Computers
6. Click the Features tab.

7. Specify the appropriate settings for your job and click OK.

These print options are specific to the DocuColor 40 CP and the DocuColor 40 (you 
must scroll to see all the pop-up menus).

The settings you choose here override settings in DocuColor 40 CP Printer Setup; the 
settings can also be changed in the Override Print Settings dialog box with 
WebSpooler. For information about these options and overrides, see Appendix A, 
“Print Options.”

If you choose Printer’s default, the job prints according to the setting entered during 
Setup.

Some PPD options are ones that could also be set from an application (for example, 
Reverse Order printing or Collation). In these cases, use the PPD option to perform 
the function, rather than setting it from the application. The application may not set 
up the file properly for printing and may also take longer to process.
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8. Choose Print in your application. 

9. If necessary, enter your name in the User area. 

Once you enter your name in the User area, it appears automatically in this dialog box 
when you print subsequent jobs. 

NOTE: This entry cannot be changed without deleting and reinstalling the printer.

10. Enter text messages in the Notes 1 and Notes 2 areas. 

You can enter user and job identification information for accounting purposes, or 
whatever information is required at your site. 

The notes you enter in these areas can be viewed from the WebSpooler, and also 
appear in the Job Log. They cannot be edited or erased by the operator. 

The notes you enter in the Notes 1 and Notes 2 areas are kept in memory and appear 
automatically in this dialog box when you print subsequent jobs. You can edit these 
notes if necessary for subsequent jobs.

11. Enter instructions to the operator about the job in the Instructions area.

These instructions can be viewed from the WebSpooler, but do not appear in the Job 
Log. They can be edited by the operator.

The instructions you enter in the Instructions area are kept in memory and appear 
automatically in this dialog box when you print subsequent jobs. You can edit these 
instructions if necessary for subsequent jobs. 

12. Click OK.
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Setting options and printing from Windows NT 4.0
To print from Windows NT 4.0, use the Adobe PostScript Printer Driver for Windows 
version 5.0 included with the DocuColor 40 CP user software.

Once you have installed the Adobe PostScript Printer Driver and the 
DocuColor 40 CP PostScript Printer Description (PPD) file, you can specify print 
settings. You can also change some of these settings for a particular job from within 
your application when you send it to the DocuColor 40 CP. Before printing, make 
sure the correct print options are set.

TO SET PRINT OPTIONS AND PRINT FROM WINDOWS NT 4.0 WITH THE 
ADOBE PS PRINTER DRIVER:

1. Click the Start button and choose Settings>Printers.

2. Right-click to select the DocuColor 40 CP and choose Document Defaults.

3. Click the Page Setup tab.

4. Specify the appropriate settings for your print job.
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From the Paper Source pop-up menu, choose the paper tray for the job. The Paper 
Source selection is valid for the current job only.

In the Paper Size pop-up menu, specify the page size for the job.

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 
type than that of the job you are sending, the DocuColor 40 CP displays an error 
message and the job will not print. You should then load the correct paper in the 
selected tray or cancel the job.

5. Click the Advanced tab.

6. Under Document Options, expand the Printer Features list and then specify print 
option settings in the list.

The print options in the Printer Features list are specific to the DocuColor 40 CP and 
the DocuColor 40. They override settings in DocuColor 40 CP Printer Setup; the 
settings can also be changed in the Override Print Settings dialog box with 
WebSpooler. For information about these options and overrides, see Appendix A, 
“Print Options.”

If you choose Printer’s default, the job prints according to the setting entered during 
Setup.



11-12 Printing from Windows Computers
Some PPD options are ones that could also be set from an application (for example, 
Reverse Order printing or Collation). In these cases, use the PPD option to perform 
the function, rather than setting it from the application. The application may not set 
up the file properly for printing and may also take longer to process.

7. Click OK.

8. Choose Print in your application.

Printing to the parallel port
The DocuColor 40 CP has a parallel port that enables you to print most files directly 
from a Windows computer if your network administrator has connected the Windows 
computer’s parallel port to the DocuColor 40 CP parallel port. 

NOTE: You cannot use Downloader through the parallel port.

TO PRINT FILES TO THE PARALLEL PORT:

1. Make sure the parallel port is enabled on your DocuColor 40 CP.

Check with your site administrator or operator to see whether printing to the parallel 
port is enabled. See Getting Started for information on setting up parallel port printing 
on your Windows computer.

2. Select the printer port that is connected to the DocuColor 40 CP parallel port.

Select one of the local ports: LPT1, LPT2, or LPT3. For instructions, see your Windows 
documentation. 

3. Print from within your application.

If you are printing a PostScript file in binary format (not ASCII), verify that the 
Network Setup option Ignore EOF Character is set to Yes. Check with your site 
administrator for this information.

Saving files to print at a remote location
If you do not have a DocuColor 40 CP and are preparing files to take to a service 
bureau or other location, print your final files to the File port (as opposed to one of the 
local ports). You can also print to the File port to create a file to be downloaded using 
Downloader. For instructions, see your Windows documentation.
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Using Downloader to print
Downloading files with Downloader is generally faster than printing from application 
software. You can use Downloader to print PostScript, EPS, or PDF files. 

TO PRINT USING DOWNLOADER:

1. Create a PostScript, EPS, or PDF file. Specify the appropriate print option settings and 
include (embed) any necessary fonts that are not resident on the DocuColor 40 CP.

For information on the fonts resident on the DocuColor 40 CP, check with the 
operator. Also see Appendix B, “Font List.”

2. Start up Downloader and connect to the DocuColor 40 CP.

For instructions on setting up Downloader, see Getting Started.

3. Select the file(s) you want to download, and specify any necessary options.

4. Click Download File(s).

For details, see Chapter 4, “Downloading Files and Fonts.”





22-1 Printing from applications
You can print to the DocuColor 40 CP just as you would print to any other printer 
from your application software. First, select the DocuColor 40 CP as the current 
printer in the Chooser, and then print the file from within your application.

Another way to print from Mac OS computers is to download PostScript, EPS, or 
PDF files using Downloader.

Printing from applications
Before you can print to the DocuColor 40 CP from applications, you must select the 
DocuColor 40 CP in the Chooser. Then, using the AdobePS 8.5.1 printer driver and 
the correct PostScript Printer Description file (PPD), you can control many 
DocuColor 40 CP printing features by specifying job settings from print dialog boxes. 

For information on achieving the best printing results from specific applications, see 
the Color Guide.

Selecting the DocuColor 40 CP in the Chooser
Before you print a job, make sure the DocuColor 40 CP is the currently selected 
printer.

TO SELECT THE DOCUCOLOR 40 CP AS THE CURRENT PRINTER:

1. Make sure the DocuColor 40 CP is connected to your network and turned on.

2. Select Chooser from the Apple menu.

3. Click the AdobePS icon to select it.
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4. If your network is divided into zones, select the zone in which the DocuColor 40 CP is 
located.

5. Select the DocuColor 40 CP in the list of printers that appears.

The names of all supported printers in the zone appear in the scroll list on the right.

NOTE: If your system administrator has not enabled the connection to the Print queue 
or the Direct connection, the corresponding printer connection will not appear in this 
list. For example, in the illustration above, only the Hold queue and the Print queue 
are enabled for the selected server. If your site has an operator who controls the flow of 
print jobs from the WebSpooler, you may be able to print only to the Hold queue.
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6. With the DocuColor 40 CP selected, click Setup.

The Chooser automatically selects the correct PPD for the DocuColor 40 CP. A 
printer icon appears to the left of the printer name, indicating that the printer has been 
matched with a PPD.

If the Chooser cannot find the correct PPD for the DocuColor 40 CP, you are 
prompted to find and select the correct PPD. If you installed the AdobePS printer 
driver as described in Getting Started, the DocuColor 40 CP PPD is located in the 
System Folder:Extensions:Printer Descriptions folder.

Printer icon
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7. In the Chooser window, make sure that AppleTalk is set to Active and then close the 
Chooser window.

The DocuColor 40 CP remains selected as the current printer until you choose a new 
printer in the Chooser. You can choose a different printer (or printer connection) from 
the Chooser or from the AdobePS print dialog box when you print (as shown below).

Setting print options and printing from Mac OS computers
In Mac OS applications, print options are set from both the Page Setup dialog box and 
the Print dialog box. For details, see Appendix A, “Print Options.” 

NOTE: Some default print options are set by the administrator during Setup. Check 
with the administrator or the operator for information on the current server default 
settings.

Choose a printer
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TO SPECIFY PRINT OPTIONS AND PRINT WITH THE ADOBEPS 8.5.1 
PRINTER DRIVER:

1. Open the file you want to print and choose Page Setup from the application’s File 
menu.

2. In the Page Setup>Page Attributes dialog box, specify settings for your print job. 

If you choose Custom as the paper size, you must also specify settings in the Page 
Setup>Custom Page Default dialog box. 

When you specify dimensions for a custom page size, the limits for various 
dimensions, as defined by the PPD, are displayed. 

Enter a custom page
name

Custom page names
displayed here

Limits for selected 
dimension displayed here
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3. If you want to save this custom page size, enter a name for it and click Add. 

Saved custom page sizes appear in the menu of page sizes at the top right of the dialog 
box. To remove a saved custom page size, choose it from the menu and click Remove. 

4. Click OK.

5. Choose Print from the application’s File menu.

Specify settings for the print options displayed. 
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6. Using the pop-up menu shown below, specify print options for your job.

Appropriate options for printing to the DocuColor 40 CP are described in the 
following steps.

NOTE: Print dialog boxes vary across applications. 

7. In the Print>Notes dialog box, enter job notes and instructions to the operator. 

In the Notes 1 and Notes 2 areas, enter user and job identification information for 
accounting purposes, or whatever information is required at your site. These notes 
appear in the Job Log; they can also be displayed from the WebSpooler. They cannot be 
edited or erased by the operator.

Set DocuColor 40 CP print 
options

Enter job notes and 
instructions to the operator

Specify color management 
settings
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In the Instructions area, enter instructions to the operator about the job. They can be 
displayed from the WebSpooler, but do not appear in the Job Log. They can be edited 
by the operator.

8. In the Print>Color Matching dialog box, specify color management settings. 

For most color print jobs you should use the settings shown above. For information on 
these options, see the Color Guide.

9. In the Print>Printer Specific Options dialog box, specify the appropriate settings for 
your print job. 
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These print options are specific to the DocuColor 40 CP and the DocuColor 40 (you 
may need to scroll to see all the options). They override settings in DocuColor 40 CP 
Setup; the settings can also be changed in the Override Print Settings dialog box from 
WebSpooler. For information about these options and overrides, see Appendix A, 
“Print Options.”

If you choose Printer’s default, the job prints according to the setting entered during 
Setup.

Some PPD options are ones that could also be set from an application (for example, 
Reverse Order printing or Collation). In these cases, use the PPD option to perform 
the function, rather than setting it from the application. The application may not set 
up the file properly for printing and may also take longer to process.

10. If you want to make the new settings your default settings, click Save Settings.

11. Click Print.

Using Downloader to print
Downloading files with Downloader is generally faster than printing from application 
software. You can use Downloader to print PostScript, EPS, or PDF files. 

TO PRINT USING DOWNLOADER:

1. Create a PostScript, EPS, or PDF file. Specify the appropriate print option settings and 
include (embed) any necessary fonts that are not resident on the DocuColor 40 CP.

For a list of fonts resident on the DocuColor 40 CP, check with the operator or see 
Appendix B, “Font List.”

2. Start up Downloader and connect to the DocuColor 40 CP.

For instructions on setting up Downloader, see Getting Started.

3. Select the file(s) you want to download, and specify any necessary options.

4. Click Download.

For details, see Chapter 4, “Downloading Files and Fonts.”





33-1 Printing to the DocuColor 40 CP
You can print to the DocuColor 40 CP directly from UNIX. Jobs printed to the 
DocuColor 40 CP are sent to the Print queue or Hold queue and can be manipulated 
from Windows and Mac OS computers on the network using WebSpooler.

NOTE: If you print to the Hold queue, an operator must intervene from WebSpooler 
for the job to print; jobs sent to the Hold queue are spooled to disk and held.

The queue name and DocuColor 40 CP printer name are established by your system 
administrator. Contact your system administrator for the names of your queues.

For information about setting up printing from TCP/IP, see your UNIX system 
documentation.

Printing to the DocuColor 40 CP
You can use UNIX commands to print PostScript files and text files to the 
DocuColor 40 CP. In general, the basic print commands (lpr, lpq, lprm) can be used 
to send print jobs to the DocuColor 40 CP. See your UNIX manual pages or other 
documentation for information about UNIX commands. 

The DocuColor 40 CP queue name referred to in the following procedures is the 
name defined in the printcap file by your system administrator.

NOTE: Only PostScript or text file formats can be printed from UNIX. 

TO PRINT FROM UNIX:

• On a system running SunOS 4.1.x or another BSD-based variant, use the lpr command 
to send a job to the DocuColor 40 CP as follows:

lpr -P queuename -# copies filename

For example, if the Print queue of your DocuColor 40 CP is named Print_server, your 
file is named Sample, and you want to print two copies, type:

lpr -P Print_server -# 2 Sample

Chapter 3:
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• On a system running Solaris 2.x or any System V implementation of UNIX, use the lp 
command to send a job to the DocuColor 40 CP as follows:

lp -d queuename -n copies filename

For example, if the Print queue of your DocuColor 40 CP is named Print_server, your 
file is named Sample, and you want to print two copies, type:

lp -d Print_server -n 2 Sample

TO DISPLAY A LIST OF JOBS IN THE QUEUE:

• On a system running SunOS 4.1.x or another BSD-based variant, use the lpq command 
to see printer jobs in the queue as follows:

lpq -P queuename

For example, if the Print queue of your DocuColor 40 CP is named Print_server, type:

lpq -P Print_server

Your workstation displays the contents of the queue.

• On a system running Solaris 2 or any System V implementation of UNIX, use the lpstat 
command to see printer jobs in the queue as follows:

lpstat -o queuename

For example, if the Print queue of your DocuColor 40 CP is named Print_server, type:

lpstat -o Print_server

Your workstation displays the contents of the queue.
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TO REMOVE JOBS FROM THE QUEUE:

NOTE: Unless you log in as the root user, you can remove only your own jobs. 

• On a system running SunOS 4.1.x or another BSD-based variant, use the lprm command 
to remove jobs from the queue as follows.

lprm -P queuename jobnumber

You can use the lpq command to check the job number.

For example, to remove job number 123 from the Print queue of your 
DocuColor 40 CP named Print_server, type:

lprm -P Print_server 123

The lprm command reports the names of any files it removes.

• On a system running Solaris 2.x or any System V implementation of UNIX, use the 
cancel command to remove jobs from the queue.

cancel queuename-jobnumber

For example, to remove job number 123 from the Print queue of your 
DocuColor 40 CP named Print_server, type:

cancel Print_server-123
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 Downloader allows you to send PostScript, EPS, and PDF files directly to the 
DocuColor 40 CP without using the application they were created in. It also enables 
you to manage printer fonts on the DocuColor 40 CP. 

You can use Downloader from a remote workstation. Downloader requires a network 
connection—you cannot use Downloader with the parallel port. For information on 
supported networking protocols, see Getting Started.

NOTE: The Windows and Mac OS versions of Downloader are fundamentally the 
same; differences are noted in this chapter. Where a window or dialog box is illustrated, 
the Windows version comes first, followed by the Mac OS version.

Using Downloader
You can use Downloader to: 

• Send PostScript, EPS, and PDF files to the DocuColor 40 CP

• Check the status of the DocuColor 40 CP

• Manage the PostScript printer fonts stored on the DocuColor 40 CP hard disk (this 
feature requires use of the Direct connection)

NOTE: Downloader was designed specifically for the DocuColor 40 CP; you cannot use 
it with any other printer. 

TO VIEW INFORMATION WITH DOWNLOADER:

1. Launch Downloader.

2. Select the DocuColor 40 CP in the Chooser window and click OK (Windows) or Connect 
(Mac OS).

Chapter 4:
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The Downloader Status window appears and you see the Downloader Toolbar, menus, 
and the status bar at the bottom of the screen. 

Buttons for some menu functions appear in the Toolbar at the top of the window:

Open Click to connect to a different 
DocuColor 40 CP.

Download Click to download a file or font to the 
DocuColor 40 CP.

Status Click to display the Status window for the current 
DocuColor 40 CP. 

Font list Click to display a list of printer fonts on the 
DocuColor 40 CP hard disk.

About 
Downloader

Click to view version information about 
Downloader.

Displays server status and user 
and document name of the job 
currently printing

Displays server status and user 
and document name of the job 
currently processing 

Dynamically displays the progress 
of the job

Displays the amount of available 
disk space
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You can click the Font list button or choose Font List from the File menu to view font 
information in the window.

3. To select a different DocuColor 40 CP, choose Open from the File menu or click the 
Open button.

4. Select the DocuColor 40 CP in the dialog box that appears, and click OK (Windows) or 
Connect (Mac OS).

5. To close the connection to the DocuColor 40 CP, make sure the Status window is active 
and choose Close from the File menu or click the close box in the Status window.

6. To quit Downloader, choose Exit (Windows) or Quit (Mac OS) from the File menu.

Printing with Downloader
Printing files with Downloader is fast—generally faster than printing from within 
applications. If you regularly print large files, try printing with Downloader.

TO DOWNLOAD A FILE OR FONT WITH DOWNLOADER:

1. Launch Downloader.

2. Choose Download from the File menu or click the Download button.
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3. Choose the file type to display from the Files of type (Windows) or Show (Mac OS) 
menu.

You can leave this at the default All Known Formats or choose All Files. All Known 
Formats lists all files in formats supported by Downloader.

4. Choose the Connection Type (Windows) or Queue (Mac OS) to which you will download 
the files.

The options available to you in this menu depend on the Setup at your site. The 
potential selections are the Print queue, Hold queue, or Direct connection. If your 
administrator has not enabled one or more of these connections, you cannot select it. 

If you choose the Direct connection, the job is spooled to the Print queue and then 
printed. If the Print queue is not enabled, the job is spooled to the Hold queue and 
must be released for printing by the operator.

To download fonts, you must use the Direct connection. If you do not have access to 
the Direct connection, you must embed any special fonts used by the file in the file 
when you generate it.

5. Select the filename and click Add File(s) (Windows) or Add (Mac OS).

The File name field (Windows) displays the name of the selected file before you click 
Add.

You can navigate to different drives and directories to select files to download. Click 
Add All (Mac OS) to add all files in a folder.



44-5 Using Downloader
To select multiple sequential files, select the first file and then Shift-click the last file. 
Control-click to select multiple non-sequential files.

If you change your mind about a file, select the filename in the Files to Download list 
and click Remove File(s) (Windows) or Remove (Mac OS).

Click Remove All (Mac OS) to remove all files from the Files to Download list.

6. To change the attributes of a file to be downloaded, select it and click Options. 

7. Specify the following information in the dialog box and click OK.

The options you set apply only to the selected file. You can set different options, or 
leave the default settings, for each file.

Copies—Specify the number of copies.

Brightness (PostScript and EPS files only)—Change the Brightness setting if a file 
appears to be too dark or too light. Choose 85% for a substantially lighter image, 115% 
for a substantially darker image, or one of the options in between. 

PostScript Options dialog box (Windows) PDF Options dialog box (Windows)

PDF Options dialog box (Mac OS)
PostScript Options dialog box (Mac OS)
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NOTE: Some applications, including Adobe Photoshop, provide transfer functions that 
let you specify density settings for an image. If the file you are printing includes 
transfer functions, the Downloader Brightness option has no effect. For more 
information on using transfer functions, see the documentation for your application.

‘showpage’ after EPS files (Windows) or ‘showpage’ (Mac OS) (EPS files only)—In 
most cases, you do not need to use this option. Select the ‘showpage’ option only if an 
EPS file fails to print without it. This option adds a ‘showpage’ PostScript language 
command at the end of the print job. Some applications omit this necessary PostScript 
language command when they generate EPS files. Select this option when printing 
EPS files generated by these applications. If you select this option unnecessarily, extra 
blank pages may print.

If you experience problems printing EPS files with Downloader, you can print the file 
directly from the application in which you created it.

Page Range (PDF files only)—Specify the page range you want to print.

8. Click Download File(s) (Windows) or Download (Mac OS).

9. To cancel downloading, press Esc (Windows) or Command-. (Mac OS).

Downloading and managing printer fonts 
Before downloading a file that uses fonts not resident on the DocuColor 40 CP, you 
must download the fonts (unless the fonts are embedded in the file). To see what fonts 
are resident on the DocuColor 40 CP, use the Font List command (see page 4-8). 

You can download fonts only via the Direct connection. If you do not have access to 
the Direct connection, you must embed any special fonts used by the file in the file 
when you generate it.

The screen fonts that correspond to the printer fonts installed on the 
DocuColor 40 CP are not automatically installed on your Windows system.

NOTE: You cannot use Downloader to download TrueType fonts. If you use TrueType 
fonts in Windows, you can print them by converting them to Adobe Type 1 fonts. To 
do this with the Adobe PS printer driver, click the Fonts tab and set up the Font 
Substitution Table as necessary. 
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Printer fonts and Mac OS screen fonts 

Like all PostScript fonts, the fonts included with the DocuColor 40 CP come in two 
forms: printer fonts and screen fonts. The printer fonts are installed permanently on 
the DocuColor 40 CP hard disk. The screen fonts, which are included with the 
DocuColor 40 CP user software, should be installed on your Mac OS computer. If 
you are using these fonts in documents you print on another printer, they are probably 
already installed. If not, you will need to install them yourself. For instructions, see 
Getting Started.

Occasionally, you may want to use Adobe Type 1 (Windows) or PostScript (Mac OS) 
fonts that are not included with the DocuColor 40 CP. If so, you will need to install 
both the screen fonts and the printer fonts on your computer. To do this, follow the 
instructions from the font manufacturer. 

Downloading printer fonts to the DocuColor 40 CP

In general, each time you print from within a Mac OS application, the application 
automatically downloads any fonts used in your document that are not already 
installed on the DocuColor 40 CP, as long as the printer fonts are installed in your 
System Folder. These fonts remain in the DocuColor 40 CP only until your document 
has printed. If you print the same document again, your application must download 
the fonts again.

If you regularly use one or more fonts from Windows or Mac OS applications that are 
not already installed in the DocuColor 40 CP, you can save time by downloading 
them to the DocuColor 40 CP hard disk with Downloader. Fonts you download to 
the DocuColor 40 CP hard disk remain installed until they are removed no matter 
how many times the DocuColor 40 CP is turned off and on. You’ll probably want to 
download fonts you use on a regular basis to the DocuColor 40 CP hard disk. 

Before you download PostScript or EPS files with Downloader, make sure that all fonts 
included in your file are installed in the DocuColor 40 CP or embedded in your file; 
otherwise the text in these fonts will not print correctly and may not print at all. For 
PDF files, font substitution occurs automatically for fonts not installed on the 
DocuColor 40 CP. Two multiple master fonts (a serif font and a sans serif font) stored 
on the DocuColor 40 CP are used exclusively for substitution with PDF files.
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TO VIEW FONT INFORMATION, UPDATE, PRINT, AND DELETE 
FONTS:

1. Choose Font List from the File menu or click the Font List button.

2. To refresh the font list display, click the Update icon.

3. To print the font list, click the Print icon.

4. To delete a font, select it in the font list and click the Delete icon. Shift-click to select 
multiple fonts. Ctrl-click to select multiple non-sequential fonts.

NOTE: The 136 printer fonts included with the DocuColor 40 CP (resident fonts) are 
locked. Locked fonts appear with a lock icon next to the name and cannot be deleted.

Update font list display

Print font list

Delete selected font(s)

Lock icon
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Update font list display

Print font list

Delete selected font(s)

Lock icon
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55-1 WebTools
The DocuColor 40 CP WebTools include two tools that allow you to monitor print 
jobs. The access privileges for these tools depend on the conditions implemented by 
your site administrator. 

WebTools
WebTools reside on the DocuColor 40 CP but can be accessed over the network from 
a variety of platforms. The DocuColor 40 CP has a home page that lets remote users 
view server functions and manipulate jobs. For an overview of WebTools and 
information on how to access them, see the Job Management Guide. This chapter 
describes only the Status and WebLink WebTools.

The Status WebTool does not require any special access privileges. If the administrator 
has enabled Web Services in Setup and has provided you with the IP address of the 
DocuColor 40 CP, you can use the Status WebTool to monitor the status of print jobs 
as they are rasterized and printed.

WebSpooler provides the capability to view and control the flow of print jobs to the 
DocuColor 40 CP. If the administrator has set Administrator and Operator passwords 
in Setup, you need one of these passwords to perform most WebSpooler functions. For 
information on WebSpooler, see the Job Management Guide.

TO ACCESS WEBTOOLS:

1. Start up your Internet browser application. 

See Getting Started for information about supported platforms and browsers.

2. Enter the IP address or the DNS name of the DocuColor 40 CP.

Check with the operator or administrator for this information.

3. If a Log In dialog box appears, select Guest and click OK.

The Log In dialog box appears only if the administrator has set Administrator or 
Operator passwords. Guest access is sufficient to use the Status and WebLink 
WebTools as described in this chapter.
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4. When the DocuColor 40 CP WebTools home page appears, click to select one of the 
WebTools.

Move the cursor over the buttons to display information about the selections.

Checking DocuColor 40 CP status with the Status WebTool
You can use the Status WebTool to see what jobs are currently processing and printing. 
To access the Status WebTool, point your browser to the DocuColor 40 CP WebTools 
home page and click Status. The current RIP Status and Printer Status appear in the 
window.

To open a new browser window for the Status display, click Float. You can then close 
other browser windows and leave the Status window open to continue checking the 
status of the DocuColor 40 CP. As long as you keep the Status window open, it is 
dynamically updated.

To obtain more information about the status of jobs, use WebSpooler. For information 
about it, see the Job Management Guide. 

Accessing information with the WebLink WebTool
The WebLink button on the DocuColor 40 CP WebTools home page provides a link 
to another web page, provided you have a valid Internet connection. The administrator 
at your site can set the WebLink destination. Check your DocuColor 40 CP WebLink 
for any information available there.
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Print options give you access to the special features of the DocuColor 40 and the 
DocuColor 40 CP. Print options can be specified in several places—in 
DocuColor 40 CP Setup, in WebSetup, from the printing application, from 
Downloader, and from WebSpooler. The table in this appendix briefly describes each 
print option, gives its default setting, and provides information on any constraints or 
requirements in effect. 

Where to set print options
• During Setup or WebSetup

Some settings are specified during Setup by the administrator. For information on 
the current default settings, check with the operator or the administrator. 

• From applications

With the Adobe PostScript printer drivers (included in your user software), you can 
specify and override job settings when you print a job. See Chapter 1, “Printing 
from Windows Computers” and Chapter 2, “Printing from Mac OS Computers” for 
information about specifying job settings from applications. 

NOTE: The job settings you specify can be overridden by the operator from the 
WebSpooler.

• From Downloader

Only a few settings—Page Range (for PDF files only), Copies, and Brightness—can 
be specified when printing jobs with Downloader. To change options in 
Downloader, select the job in the Files to be Downloaded (Windows) or Files to 
Download (Mac OS) list and click Options. For more information, see Chapter 4, 
“Downloading Files and Fonts.”

• Overrides from WebSpooler

To change job settings from WebSpooler, double-click a job to display the Override 
Print Settings dialog box. For more information, see the Job Management Guide.

Appendix A: 
Print Options
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Print options and override hierarchy
In the following table, the default printer driver settings (PPD defaults) are underlined. 
The Printer’s Default setting indicates that a default has been specified in 
DocuColor 40 CP Setup. To find out about the current Setup defaults, print the 
Configuration page from the DocuColor 40 CP Control Panel.

The override hierarchy is as follows: 

• A user’s printer driver settings override the DocuColor 40 CP Setup settings.

• Settings made from WebSpooler override the user’s printer driver settings. 

Option and settings:
(Default setting is underlined)

Description:
Requirements, constraints, 

and information:

Brightness
85% Lightest/90% Lighter/
95% Light/100% Normal/105% Dark/
110% Darker/
115% Darkest

Select 85% for a substantially lighter 
image, 115% for a substantially darker 
image, or one of the settings in between.

CMYK Simulation
Printer’s Default/SWOP-Coated/DIC/
Euroscale/Custom-1/Custom-2/
Custom-3/Custom-4/Custom-5/None/
Match Copy

Select a CMYK simulation target to use 
for the job.

See the Color Guide for more 
information.

CMYK Simulation Method
Printer’s Default/Quick/Full

Select Quick to apply one-dimensional 
transfer curves that adjust output density. 
Select Full to apply four-dimensional 
transfer curves that adjust hue as well as 
output density. 

See the Color Guide for more 
information.

Collation
Collated/Uncollated

For a multiple-copy, multiple-page job, 
specify whether or not to collate the job.

Color Mode
CMYK/Grayscale

Specify the color mode for the current 
print job. Select CMYK for a full-color 
document or Grayscale for a grayscale or 
black-and-white document.
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Combine Separations
Off/On

When printing separations from a 
desktop publishing application:
Select On to combine separations on a 
single page. Select Off to view separations 
as four individual grayscale pages, each 
representing one color plate.

See page A-6 for more information.

Copier Mode
Text Enhancement/Photo/Map

Select Text Enhancement or Photo if the 
file is a photograph. Select Map if the file 
is a combination of text and photographs.

Copies
1 - 999

Specify the number of copies of the job to 
print.

Duplex
Off/Top-Top/Top-Bottom

Select Off for simplex (single sided) 
printing, select Top-Top for duplex 
(double sided) printing with both sides 
using the same top edge, or select 
Top-Bottom for duplex printing with the 
back side upside down.

If the Suspend Printing command is used 
during printing of a duplex job, printing 
cannot be resumed—the job must be 
resent.

Face Down Printing
No/Yes

Select No to print your documents on the 
top of the paper, select Yes to print your 
documents on the bottom of the paper 
(the document will output from the 
copier with a blank page facing up and 
the text facing down).

Instructions Use this field to enter instructions to the 
operator about the job (see also Notes 1 
and Notes 2).

The instructions field has a 128-character 
limit.

Media Type (Paper Type)
Plain Paper/Thick Paper/Transparency/
Interleaved/Opaque Film

Specify the type of media on which to 
print the job. Select Interleaved if you 
will be printing multiple transparencies 
with blank paper separators.

Notes 1 and Notes 2 Use one or both of these fields to enter 
special information about the job (see 
also Instructions).

The Notes 1 and Notes 2 fields each have 
a 32-character limit.

Option and settings:
(Default setting is underlined)

Description:
Requirements, constraints, 

and information:
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(Other) Gamma
Printer’s Default/1.0/1.2/1.4/1.6/1.8/
2.0/2.2/2.4/2.6/2.8/3.0

Specify a source gamma value for 
printing RGB images, objects, and text.

To enable this option, RGB Source must 
be set to Other.

See the Color Guide for more 
information.

(Other) Phosphors
Printer’s Default/Hitachi EBU/
Hitachi-Ikegami/NTSC/Radius Pivot/
SMPTE/Trinitron

Specify a source monitor phosphors value 
for printing RGB images, objects, and 
text.

To enable this option, RGB Source must 
be set to Other.

See the Color Guide for more 
information.

(Other) White Point
Printer’s Default/5000 K (D50)/
5500 K/6500 K (D65)/7500 K/9300 K

Specify a source white point value for 
printing RGB images, objects, and text.

To enable this option, RGB Source must 
be set to Other.

If you set this option to anything other 
than Printer’s Default, set the Rendering 
Style option to Solid Color for best 
results.

See the Color Guide for more 
information.

Page Order
Forward/Reverse

Select Forward for front-to-back output or 
Reverse for back-to-front output.

Paper Size 
Letter/A4/11 x 17/A3/12x18/Legal/
Legal 13/B4/B5/A6/SEF Letter/
SEF A4/SEF B5/SEF 8x10/8x10/9x11/
9x12/Docupac/Custom 1/Custom 2/
Custom 3

Specify the size of the paper on which to 
print the document. Custom paper sizes 
can be defined with Mac OS or Windows 
computers using the Adobe PostScript 
Printer Driver provided with your 
DocuColor 40 CP user software.

For instructions on how to define custom 
paper sizes, see Chapters 2 and 3.

Paper Source
Auto Select/Tray 1/Tray 2/Tray 3/
Bypass Tray

Specify the source for the media on 
which to print the job.

See page A-8 for more information.

Rendering Style
Photographic/Presentation/
Solid Color/None

Specify a color rendering dictionary 
(CRD) to be used when you print RGB 
images, objects, and text. 

The Color Mode option must be set to 
CMYK. The Rendering Style option has 
no effect on CMYK data.

See page A-8 and the Color Guide for 
more information.

Option and settings:
(Default setting is underlined)

Description:
Requirements, constraints, 

and information:
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More information about print options
The following sections provide additional information about print options. See the 
table above for information on the settings, requirements, and constraints in effect for 
these options.

CMYK Simulation

CMYK Simulation allows you to change the simulation goal for the current print job 
only. As the job begins processing, the simulation goal selected in CMYK Simulation is 
applied before printing.

NOTE: Choosing Printer’s Default results in the job being printed with the simulation 
goal currently set on the DocuColor 40 CP.

RGB Source
Printer’s Default/EFIRGB/sRGB (PC)/
Apple Standard/Other/Off

Specify a source color space definition for 
printing RGB images, objects, and text.

See page A-8 and the Color Guide for 
more information.

Save Fast Reprint
Off/On

Specify whether or not to save the job’s 
raster data to disk after printing, so the 
data will be available later for reprinting 
(without reRIPping).

Scale
100%/200%/150%/75%/50%

Specify the percentage at which to print 
the job.

See page A-9 for more information.

Slip Sheet
Off/On

Specify whether to insert a slip sheet 
between copies of multiple-copy jobs. 

Sorter
Off/On

Specify whether or not to sort the job. If the Suspend Printing command is used 
during printing of a sort job, printing 
cannot be resumed—the job must be 
resent. 

The Slip Sheet option must by set to Off 
to set this option to On.

Stapler
Off/On

Specify whether or not to staple the job. If the Suspend Printing command is used 
during printing of a staple job, printing 
cannot be resumed—the job must be 
resent. 

Option and settings:
(Default setting is underlined)

Description:
Requirements, constraints, 

and information:
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SWOP-Coated—Uses the United States press standard.

DIC—Uses the Japanese press standard.

Euroscale—Uses the European press standard.

Custom-1(2, 3, 4, 5)—Uses a custom simulation goal. Before selecting this setting, 
you are required to create a new simulation goal with Print Calibrator and name the 
simulation goal exactly as it appears in the options list.

None—Uses no simulation goal. Select this setting when the CMYK data for your job 
has already been separated for your specific printer (for example, when using the Color 
Management System built into your computer to convert the CMYK data to the 
printer’s color space).

Match Copy—Uses no calibration or simulation goal. Select this setting when you want 
to bypass DocuColor 40 CP calibration and simulation.

For more information about calibration, see the Job Management Guide.

Combine Separations

The Combine Separations option specifies whether to combine color separations 
created in desktop publishing applications on a single page to simulate printing on a 
press from film separations. It allows you to proof overprinting, trapping, and other 
four-color printing effects before having film separations created. It also enables you to 
combine Desktop Color Separations (DCS) format files to print them at full resolution 
instead of printing the low-resolution master file. 

Your job must have been printed as color separations or DCS format when you printed 
it from your application. If you did not print the job in this manner, the Combine 
Separations option has no effect. 

NOTE: This option is supported only for Adobe PageMaker and QuarkXPress.
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Duplex 

All duplex printing features are available only with plain paper media type.

TO PRINT DUPLEX PAGES:

1. Choose Print in your application, and locate the Duplex print option.

The location of DocuColor 40 CP print options varies, depending on the printer 
driver you are using.

2. Choose one of the Duplex settings:

Top-Top—Prints the top of the image on side 1 on the same edge of the page as the top 
of the image on side 2.

Top-Bottom—Prints the top of the image on side 1 on the opposite edge of the page 
from the top of the image on side 2.

The following table shows how the Duplex settings correspond to printed output:

Page Order

If you print a job consisting of many pages with the Page Order option set to Reverse, 
the job may print in sections that have to be manually rearranged after printing. For 
example, if you print a 450-page document in reverse order, the DocuColor 40 CP 
might divide the job into three portions, first printing page 150 to page 1, then page 
300 to page 151, and finally page 450 to page 301. 

Top-Top Top-Bottom

Portrait

Landscape

1 2 1

2

1

2

1 2
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Paper Source

If you choose the Auto Select setting, the copier prints from any tray containing the 
paper size needed for the job. This setting also allows the copier to automatically 
switch between trays, if the current tray becomes empty, while continuing to print. 

Rendering Style

Use this option to select a default color rendering dictionary (CRD) to be used when 
you print RGB images, objects, and text. 

Photographic—Optimizes the range of colors on the DocuColor 40 CP to produce the 
best results for photographic or bitmapped images. 

Presentation—Optimizes the output of pure, saturated colors such as those used in 
business presentations. It treats continuous tone images in the same way as the 
Photographic CRD does.

Solid Color—Most useful for printing spot colors such as those found in company 
logos or corporate charts and graphics. Provides the best color accuracy for images 
using PANTONE colors. This setting is recommended when the (Other) White Point 
option is set to anything other than Printer’s Default.

For information on color rendering and color management, see the Color Guide.

RGB Source

This option is used to specify a source color space for RGB data. 

EFIRGB—Optimal source space for printing to the DocuColor 40 CP Color Server. 
This setting provides consistent output across platforms. 

sRGB (PC)—Specifies the source space of a generic Windows computer monitor.

Apple Standard—Specifies the source space of a Mac OS computer monitor.

Other—Allows you to specify a custom RGB source setting using the (Other) Gamma, 
(Other) Phosphors, and (Other) White Point print options.

For information on source color space and color management, see the Color Guide.
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Scale

The operator can specify a scaling override, but the override is applied to the scaling 
value already set in the active job. For example, if a user sends a job with a scaling value 
of 50% and the operator specifies a Scale override of 200%, the job is printed at 100% 
of the original document size, that is, 50% of 200%.

Sorter 

Sorting is supported on color copiers with a sorter unit attached.

Off—Disables the sorter

On—Copies of a complete job are sorted and output into one of 20 bins, arranged in 
page order.

Stapler 

Off—Disables the stapler.

On—The job is stapled with one staple along the corner of the page edge that first exits 
the copier.
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This appendix lists the built-in printer fonts included with your DocuColor 40 CP.

Printer fonts
Listed below are the 136 built-in printer fonts on the DocuColor 40 CP.

In addition to the fonts listed below, two Adobe Multiple Master fonts are included 
and are used for font substitution in PDF files.

NOTE: For Mac OS computers, install the corresponding screen fonts from the User 
Software CD. For instructions, see Getting Started.

Adobe Type 1 fonts
The DocuColor 40 CP includes 117 Adobe Type 1 fonts:

• The Mac OS column lists the name as it appears on the Font menu on a Mac OS 
computer. For example, in most applications, to use “Bodoni-Bold,” choose Bodoni 
Bold from the Font menu.

• The Windows menu name is the name as it appears on the Font menu on a 
Windows computer. The style refers to the style that must be selected in the 
application to access the particular PostScript font. For example, to use “Bodoni-
Bold,” choose Bodoni from the Font menu and Bold from the Style menu.

PostScript name: Mac OS menu name: Windows menu name, style: 

AlbertusMT-Light Albertus MT Lt Albertus MT Lt 

AlbertusMT Albertus MT Albertus MT 

AlbertusMT-Italic Albertus MT It Albertus MT, Italic 

AntiqueOlive-Roman Antique Olive Roman Antique Olive Roman

AntiqueOlive-Bold Antique Olive Bold Antique Olive Roman, Bold

AntiqueOlive-Italic Antique Olive Italic Antique Olive Roman, Italic

AntiqueOlive-Compact Antique Olive Compact Antique Olive Compact

AvantGarde-Book Avant Garde AvantGarde

AvantGarde-Demi Avant Garde Demi AvantGarde, Bold

AvantGarde-BookOblique Avant Garde BookOblique AvantGarde, Italic

Appendix B: 
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AvantGarde-DemiOblique Avant Garde DemiOblique AvantGarde, Bold Italic

Bodoni Bodoni Bodoni

Bodoni-Bold Bodoni Bold Bodoni, Bold

Bodoni-Italic Bodoni Italic Bodoni, Italic

Bodoni-BoldItalic Bodoni BoldItalic Bodoni, Bold Italic

Bodoni-Poster Bodoni Poster Bodoni Poster

Bodoni-PosterCompressed Bodoni PosterCompressed Bodoni PosterCompressed 

Bookman-Light Bookman Bookman 

Bookman-Demi Bookman Demi Bookman, Bold 

Bookman-LightItalic Bookman LightItalic Bookman, Italic 

Bookman-DemiItalic Bookman DemiItalic Bookman, Bold Italic

Carta Carta Carta

Clarendon-Light Clarendon Light Clarendon Light 

Clarendon Clarendon Clarendon 

Clarendon-Bold Clarendon Bold Clarendon, Bold

CooperBlack Cooper Black Cooper Black 

CooperBlack-Italic Cooper Black Italic Cooper Black, Italic

Copperplate-ThirtyThreeBC Copperplate33bc Copperplate33bc

Copperplate-ThirtyTwoBC Copperplate32bc Copperplate32bc

Coronet Coronet Coronet

Courier Courier Courier 

Courier-Bold Courier Bold Courier, Bold 

Courier-Oblique Courier Oblique Courier, Italic 

Courier-BoldOblique Courier BoldOblique Courier, Bold Italic

Eurostile Eurostile Eurostile

Eurostile-Bold Eurostile Bold Eurostile Bold

Eurostile-ExtendedTwo Eurostile ExtendedTwo Eurostile ExtendedTwo

Eurostile-BoldExtendedTwo Eurostile BoldExtendedTwo Eurostile ExtendedTwo, Bold

GillSans GillSans GillSans 

GillSans-Bold GillSans Bold GillSans, Bold 

GillSans-Italic GillSans Italic GillSans, Italic 

GillSans-BoldItalic GillSans BoldItalic GillSans, Bold Italic 

GillSans-Light GillSans Light GillSans Light 

GillSans-LightItalic GillSans LightItalic GillSans Light, Italic

PostScript name: Mac OS menu name: Windows menu name, style: 
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GillSans-Condensed GillSans Condensed GillSans Condensed 

GillSans-BoldCondensed GillSans BoldCondensed GillSans Condensed, Bold 

GillSans-ExtraBold GillSans ExtraBold GillSans ExtraBold 

Goudy Goudy Goudy 

Goudy-Bold Goudy Bold Goudy, Bold 

Goudy-Italic Goudy Italic Goudy, Italic 

Goudy-BoldItalic Goudy BoldItalic Goudy, Bold Italic

Goudy-ExtraBold Goudy ExtraBold Goudy ExtraBold

Helvetica Helvetica Helvetica 

Helvetica-Bold Helvetica Bold Helvetica, Bold 

Helvetica-Oblique Helvetica Oblique Helvetica, Italic 

Helvetica-BoldOblique Helvetica BoldOblique Helvetica, Bold Italic

Helvetica-Narrow Helvetica Narrow Helvetica-Narrow 

Helvetica-Narrow-Bold Helvetica Narrow Bold Helvetica-Narrow, Bold 

Helvetica-Narrow-Oblique Helvetica Narrow Oblique Helvetica-Narrow, Italic 

Helvetica-Narrow-BoldOblique Helvetica Narrow BoldObl Helvetica-Narrow, Bold Italic

Helvetica-Condensed Helvetica Condensed Helvetica Condensed 

Helvetica-Condensed-Bold Helvetica CondensedBold Helvetica Condensed, Bold 

Helvetica-Condensed-Oblique Helvetica CondensedOblique Helvetica Condensed, Italic 

Helvetica-Condensed-BoldObl Helvetica CondensedBoldObl Helvetica Condensed, Bold Italic

JoannaMT Joanna MT Joanna MT 

JoannaMT-Bold Joanna MT Bd Joanna MT, Bold 

JoannaMT-Italic Joanna MT It Joanna MT, Italic

JoannaMT-BoldItalic Joanna MT Bd It Joanna MT, Bold Italic

LetterGothic Letter Gothic Letter Gothic 

LetterGothic-Bold Letter Gothic Bold Letter Gothic, Bold 

LetterGothic-Slanted Letter Gothic Slanted Letter Gothic, Italic 

LetterGothic-BoldSlanted Letter Gothic BoldSlanted Letter Gothic, Bold Italic

LubalinGraph-Book Lubalin Graph LubalinGraph 

LubalinGraph-Demi Lubalin Graph Demi LubalinGraph, Bold 

LubalinGraph-BookOblique Lubalin Graph BookOblique LubalinGraph, Italic 

LubalinGraph-DemiOblique Lubalin Graph DemiOblique LubalinGraph, Bold Italic 

Marigold Marigold Marigold

MonaLisa-Recut Mona Lisa Recut Mona Lisa Recut

PostScript name: Mac OS menu name: Windows menu name, style: 



NewCenturySchlbk-Roman New Century Schlbk NewCenturySchlbk 

NewCenturySchlbk-Bold New Century Schlbk Bold NewCenturySchlbk, Bold 

NewCenturySchlbk-Italic New Century Schlbk Italic NewCenturySchlbk, Italic 

NewCenturySchlbk-BoldItalic New Century Schlbk BoldIt NewCenturySchlbk, Bold Italic

Optima Optima Optima 

Optima-Bold Optima Bold Optima, Bold 

Optima-Italic Optima Italic Optima, Italic 

Optima-BoldItalic Optima BoldItalic Optima, Bold Italic

Oxford Oxford Oxford

Palatino-Roman Palatino Palatino 

Palatino-Bold Palatino Bold Palatino, Bold 

Palatino-Italic Palatino Italic Palatino, Italic 

Palatino-BoldItalic Palatino BoldItalic Palatino, Bold Italic

StempelGaramond-Roman StempelGaramond Roman StempelGaramond Roman 

StempelGaramond-Bold StempelGaramond Bold StempelGaramond Roman, Bold 

StempelGaramond-Italic StempelGaramond Italic StempelGaramond Roman, Italic 

StempelGaramond-BoldItalic StempelGaramond BoldItalic StempelGaramond Roman, Bold 
Italic

Symbol Symbol Symbol

Tekton Tekton Tekton

Times-Roman Times Times

Times-Bold Times Bold Times, Bold

Times-Italic Times Italic Times, Italic

Times-BoldItalic Times BoldItalic Times, Bold Italic

Univers-Extended Univers Extended Univers Extended 

Univers-BoldExt Univers BoldExt Univers Extended, Bold 

Univers-ExtendedObl Univers ExtendedObl Univers Extended, Italic 

Univers-BoldExtObl Univers BoldExtObl Univers Extended, Bold Italic 

Univers-Light Univers 45 Light Univers 45 Light 

Univers-Bold Univers 65 Bold Univers 45 Light, Bold 

Univers-LightOblique Univers 45 LightOblique Univers 45 Light, Italic 

Univers-BoldOblique Univers 65 BoldOblique Univers 45 Light, Bold Italic 

Univers Univers 55 Univers 55 

Univers-Oblique Univers 55 Oblique Univers 55, Italic 

PostScript name: Mac OS menu name: Windows menu name, style: 
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TrueType fonts
The DocuColor 40 CP includes 19 TrueType fonts:

Univers-CondensedBold Univers 67 CondensedBold Univers 47 CondensedLight, 
Bold 

Univers-CondensedBoldOblique Univers 67 CondensedBoldObl Univers 47 CondensedLight, 
Bold Italic 

Univers-Condensed Univers 57 Condensed Univers 57 Condensed 

Univers-CondensedOblique Univers 57 CondensedOblique Univers 57 Condensed, Italic

ZapfChancery-MediumItalic Zapf Chancery ZapfChancery

ZapfDingbats Zapf Dingbats ZapfDingbats

PostScript name: Mac OS menu name: Windows menu name, style: 

Apple-Chancery Apple Chancery Apple Chancery

Arial-BoldItalicMT Arial Bold Italic Arial, Bold Italic

Arial-BoldMT Arial Bold Arial, Bold

Arial-ItalicMT Arial Italic Arial, Italic

ArialMT Arial Arial

Chicago Chicago Chicago

Geneva Geneva Geneva

HoeflerText-Black Hoefler Text Black Hoefler Text Black

HoeflerText-BlackItalic Hoefler Text Black Hoefler Text Black, Italic

HoeflerText-Italic Hoefler Text Hoefler Text, Italic

HoeflerText-Ornaments Hoefler Text Ornaments Hoefler Text Ornaments

HoeflerText-Regular Hoefler Text Hoefler Text

Monaco Monaco Monaco

New York New York New York

TimesNewRomanPS-BoldMT Times New Roman Bold Times New Roman, Bold

TimesNewRomanPS-
BoldItalicMT

Times New Roman Bold Italic Times New Roman, Bold Italic

TimesNewRomanPS-ItalicMT Times New Roman Italic Times New Roman, Italic

TimesNewRomanPSMT Times New Roman Times New Roman

Wingdings-Regular Wingdings Wingdings

PostScript name: Mac OS menu name: Windows menu name, style: 
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This appendix provides troubleshooting tips.

Maintaining optimal system performance
The DocuColor 40 CP does not require maintenance. Beyond the routine 
requirements of servicing and maintaining the copier and replenishing consumables 
there are a few things you can do to improve the overall performance of your system:

• Reduce unnecessary two-way communication.

If you notice that the server is frequently too busy to receive jobs, it may be because 
several users are running DocuColor 40 CP utilities that are updated often. Large 
numbers of remote users running Downloader or WebTools may have a significant 
effect on DocuColor 40 CP performance.

• Reduce unnecessary server connections. If you use a second or third 
DocuColor 40 CP Color Server on an occasional basis, performance will be 
improved if you log off when you are not using it.

• Avoid printing with the server “Disk full” warning. 

If you see this warning, ask the operator to use WebSpooler to delete jobs that have 
been held for a long time and are not likely to be needed. Avoid this condition by 
deleting old jobs on a regular basis. The date associated with a job is the original date 
it was sent.

Even when the disk is full, 128KB of disk space is reserved for printing a tabloid size 
job, but printing proceeds only when the oldest printed job is deleted from the 
Printed queue (Print area in WebSpooler Job List window).

Troubleshooting

In case of problems, and before you call for service, check the guidelines in this section. 
If you are unable to resolve the problem, make a note of the error condition and 
contact your authorized service/support center.

Appendix C: 
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This section provides some troubleshooting guidelines should a problem arise. If you 
are unable to resolve a problem after referring to this section, contact your site operator 
or administrator. 

General printing problems

If this happens: Try this:

You cannot select or view one 
of the print connections.

• Have your system administrator enable the print connection in Setup.

Printing ties up your 
computer for too long.

• Print to a queue instead of to the Direct connection.

When you print to a queue, the job is stored on the DocuColor 40 CP until it can be 
processed and printed; when you print to the Direct connection, the job cannot be sent 
to the DocuColor 40 CP until the previous job is finished processing, so you must wait 
longer to use your computer.

Special paper or transparency 
options are dimmed.

• Select a Paper Source that supports the media type you are using.

Message requests a paper size 
that you don’t have.

• Cancel the job and do one of the following:

If you are printing a PostScript file, ask the administrator to set the Convert Paper Sizes 
setting in PS Setup to convert the job to a paper size you do have. You can do this to 
convert between US and metric paper sizes.

If you are printing a file from an application, change the page size in the Page Setup 
dialog box.

You cannot print with 
QuarkXPress 3.32 using the 
AdobePS 8.5.1 driver on a 
Mac OS computer.

• Remove the file called Balloon Help from your QuarkXPress application folder and 
relaunch QuarkXPress.
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DocuColor 40 CP doesn’t 
respond to a Print command.

• Has someone disconnected the copier by selecting Suspend Printing from the Functions 
menu?

If the administrator or operator has selected Suspend Printing on the DocuColor 40 CP 
Control Panel to interrupt printing (so that someone can make a color copy, for 
example), your print job will not resume until someone selects Resume Printing from the 
Functions menu on the Control Panel.

• Did you select the DocuColor 40 CP as the current printer?

Before printing, you must select the DocuColor 40 CP as the current printer from your 
Mac OS, Windows, or UNIX workstation.

• Make sure that the copier is switched on.

Someone may have turned the copier off, or the Automatic Power-Off or Power Saver 
mode function may have engaged. Even with the copier off, the DocuColor 40 CP 
appears in the Chooser as long as the DocuColor 40 CP itself is turned on. 

• If you are printing over an IPX (Novell) network, verify through the PCONSOLE utility 
that the job was sent to the Novell queue and that the queue is being used by the 
DocuColor 40 CP.

• Make sure that the job does not contain a PostScript error.

Check with the operator, or use WebSpooler to check the job’s status. A job containing 
a PostScript error appears in red in the WebSpooler displays.

Jobs sent to the parallel port 
do not print.

• Review the procedures provided in Getting Started on how to prepare the 
DocuColor 40 CP and your Windows 95 computer for parallel port printing.

Also see your Windows 95 documentation.

• Ask the administrator to increase the parallel “Port Timeout in Seconds” on the 
DocuColor 40 CP Control Panel.

• Ask the administrator to change the Ignore EOF Character setting on the 
DocuColor 40 CP Control Panel.

If you will be printing ASCII format PostScript only, set Ignore EOF Character to No; if 
you will be printing Binary format PostScript, set it to Yes.

• If you print using the DOS copy command, make sure to use the /b option when 
printing binary files.

• If the PostScript printer driver that you are using lets you select bidirectional 
communication, make sure that it is disabled. 

This is generally set from the Properties dialog box for the printer. 

If this happens: Try this:



CC-4 Troubleshooting
Problems with print quality 

If this happens: Try this:

Print settings for your job 
output do not match the 
settings you gave.

• Make sure that you did not override the setting for the job in another place.

For information about options and overrides, see Appendix A "Print Options."

You get poor printing results. • Does your application require one of DocuColor 40 CP printer description files?

If you’re printing from an application such as Adobe Separator or PageMaker, 
MacroMedia FreeHand, or QuarkXPress, make sure that the DocuColor 40 CP printer 
description file is installed correctly. For information about installing these files, see 
Getting Started.

• Use a different Copier Mode option.

For DocuColor 40 CP Color Server systems, the default Copier Mode setting is Text 
Enhancement. Try changing the setting to Photo and see if the results improve.

• Make sure the system has been calibrated.

Separations do not combine 
properly.

• Make sure that the file was initially created as separations.

• If you are printing separations or a DCS format file, set the Combine Separations print 
option to On. 

With Combine Separations On, all four colors will be printed on a single page; with 
Combine Separations Off, four grayscale pages will print to simulate four single-color 
plates.

The registration or colors of 
an image are not what you 
expected.

• Ask the operator to print a test page or make a test copy with the copier.

The problem may be with the copier. If your test page or copy show that the copier is 
working properly, correct the problem within your application software. If the test page 
or copy are wrong, your copier may need to be calibrated or adjusted in some other 
way. 

Your printed file appears too 
dark.

• Adjust the Brightness option.

You can use the Brightness option when printing from an application or from 
Downloader to lighten your image whenever you print a PostScript or Encapsulated 
PostScript (EPS) file. 

Color output is incorrect. • Check with the operator or administrator about the current calibration information. 

The copier may need to be recalibrated because it has been too long since it was 
calibrated or because it is using a different target.



CC-5 Troubleshooting
Problems with Downloader

Color file prints in black and 
white.

• In the Print Options dialog box, make sure that Color/Grayscale or ColorSync Color 
Matching or PostScript Color Matching is selected (not Black and White).

• Make sure that the Color Mode selected for the job is CMYK and not Grayscale.

Desktop Color Separations 
(DCS) format images print 
incorrectly.

• Make sure that you selected the correct options to send separations in the application’s 
Print dialog box.

• Make sure that you have the file for every layer of separation that you are printing.

• Set the Combine Separations option to On.

This combines the high-resolution files for an image and prints them. With Combine 
Separations Off, the low-resolution master file will print.

QuickDraw fill patterns print 
as solids.

• Use the Adobe PostScript Printer driver (or the Apple LaserWriter 8.3 or later printer 
driver).

If this happens: Try this:

You cannot connect to the 
DocuColor 40 CP from 
Downloader.

• Make sure that the DocuColor 40 CP is not being calibrated.

If the DocuColor 40 CP is being calibrated, you cannot connect to it. This insures that 
only one person is calibrating the server at any time and that print jobs do not use 
unexpected calibration.

You can’t print an EPS file 
using Downloader.

• Try printing using the “Showpage” option in the Download PostScript File dialog box.

The Showpage (after EPS files) option adds a showpage PostScript language command 
at the end of the print job. Certain applications omit this necessary PostScript language 
command when they generate EPS files. You’ll need to select the Append Showpage 
option when printing EPS files generated by these applications.

If you continue having difficulties printing an EPS file with Downloader, try printing 
the file from the application in which it was created.

• Make sure that the job does not contain a PostScript error.

Check with the operator, or use WebSpooler to check the job’s status. A job containing 
a PostScript error appears in red in the WebSpooler display.

You have problems 
downloading a font with 
Downloader.

• Check with the administrator to make sure that the Direct connection is enabled.

The Direct connection must be used to download fonts. (Files can be downloaded via 
the Print or Hold queue.)

If this happens: Try this:



CC-6 Troubleshooting
Problems with WebTools

Extra blank page prints after a 
Downloader job.

• Turn off the “Showpage (after EPS file)” option.

This option adds a special PostScript command that will cause an extra blank page to 
print if it is not needed.

If this happens: Try this:

General problems • Clear the cache (Netscape Communicator) or history (Microsoft Internet Explorer).

If this happens: Try this:
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A
Adobe Photoshop, transfer functions 4-6
Adobe PostScript Printer Driver, see  

PostScript printer drivers
applications, setting print options from 1-4, 

1-8, 1-12, 2-9

B
Brightness option 4-5, A-1, A-2

C
cancel command (UNIX) 3-3
Chooser window (Mac OS), selecting color 

server in 2-1 to 2-4
CMYK Simulation Method option A-2
CMYK Simulation option A-2, A-5
Collation option A-2
color, troubleshooting output C-4
Color Mode option A-2
color rendering dictionaries, see CRDs
color server

documentation xii
selecting as current printer 2-1

Combine Separations option A-3, A-6
Contone mode xiii
Copier Mode option A-3, C-4
Copies option A-3
CRDs (color rendering dictionaries) A-4

D
DCS (Desktop Color Separations) files A-3, 

A-6
default settings, see printer default settings
Desktop Color Separations, see DCS
DIC simulation goal A-6
Direct connection xiv, 4-4

not in Chooser (Mac OS) 2-2
required to download fonts 4-6, C-5

Downloader
choosing a printer 4-3
Connection Type option 4-4
Copies option 4-5
downloading files or fonts 4-3 to 4-6
Download Progress bar 4-2
Font List option 4-3
Hard Disk area 4-2
Mac OS 2-9
printing from 4-3
Print Status area 4-2
restriction with parallel port 1-12
RIP Status area 4-2
troubleshooting C-5 to C-6
using from remote workstation 4-1
Windows 95 1-1
Windows NT 4.0 1-1

Duplex option A-3, A-5, A-7

E
end-of-file (EOF) character 1-12
EPS files 1-13, 2-9, C-5
Euroscale simulation goal A-6

F
File port, saving files to 1-12
font list

displaying 4-2
printing 4-2

Font List option (Downloader) 4-3
fonts

Adobe Type 1 4-6, 4-7, B-1
downloading and managing 4-1, 4-4, 

4-6, 4-7
list, displaying 4-8
locked 4-8
PostScript B-1
printer fonts 4-7
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screen fonts (Mac OS) 4-7
TrueType 4-6, B-5

Font Substitution Table 4-6
Full Color mode xiii

G
Gamma option A-4
Grayscale mode xiii

H
Hold queue xiv, 2-2, 4-4

I
Instructions field 1-5, 1-9, 2-7, 2-8, A-3

J
Job Log 1-5, 1-9, 2-8
job overrides

CMYK Simulation option A-5
Duplex option A-7
Sorter option A-9
Stapler option A-9

job settings,  see  print options

L
lock icon 4-8
lp command 3-2
lpq command 3-1, 3-2, 3-3
lpr command 3-1
lprm command 3-1, 3-3

M
Mac OS

PostScript printer drivers 2-5 to 2-9
printing 2-1 to 2-9
printing with Downloader 2-9, 4-1 to 

4-8
print options 2-4 to 2-9

Match Copy simulation goal A-6
Media Type option 1-2, A-3

N
None simulation goal A-6
Notes 1 and Notes 2 fields, see Notes fields
Notes fields

Mac OS 2-7
option A-3
Windows 3.1x 1-9
Windows 95 1-5

O
operator instructions A-3
(Other) Gamma option A-4, A-8
(Other) Phosphors option A-4, A-8
(Other) White Point option A-4, A-8

P
Page Order option A-4, A-7
Page Range option A-1
paper

Custom size setting 1-3, 2-5
standard sizes supported xiii

Paper Size option A-4
Paper Source option 1-2, A-4, A-8
parallel port

printing problems C-3
printing with 1-12

PDF files 1-13, 2-9, 4-1
performance, optimizing C-1
Phosphors option A-4
Photographic rendering style A-4, A-8
Plain paper A-3
PostScript

downloading files, Mac OS 2-9
downloading files, Windows 1-13
downloading files with Downloader 4-1
printing files from UNIX 3-1

PostScript printer description files, see PPD 
files

PostScript printer drivers
description xiii
for Mac OS 2-5 to 2-9
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for Windows 3.1x 1-7 to 1-9
for Windows 95 1-1 to 1-5
for Windows NT 4.0 1-10 to 1-12
Microsoft PostScript printer driver for 

Windows NT 4.0 1-10 to 1-12
PPD (PostScript Printer Description) files

defaults A-2
description xiii
options 1-4, 1-8, 1-12, 2-9
Windows 3.1x settings 1-6
Windows 95 settings 1-1

Presentation rendering style A-4, A-8
printer default settings xiii, A-1 to A-9
printer driver,  see PostScript printer drivers
printing

duplex pages A-7
font list 4-2
from Downloader 2-9, 4-1 to 4-8
Mac OS 2-1 to 2-9
parallel port 1-12
saving files for printing at remote 

location 1-12
specifying trays A-4
to File Port 1-12
to local port 1-12
troubleshooting C-2 to C-6
UNIX workstations 3-1 to 3-3
Windows 3.1x 1-6 to 1-9
Windows 95 1-1 to 1-6
Windows 95 1-6
Windows NT 4.0 1-10 to 1-12

printing connections on the network xiv
print options

Mac OS 2-4 to 2-9
settings 1-6, A-1 to A-9
specific to color server 1-4
Windows 3.1x 1-6 to 1-9
Windows 95 1-1 to 1-6
Windows NT 4.0 1-11 to 1-12
see also printer default settings

Print queue xiv, 2-2, 4-4

Q
QuarkXPress, printing problems C-2
queues, access to xiv

R
remote access xi, 4-1
Rendering Style option A-4
RGB Source option A-5, A-8

S
Save Fast Reprint option A-5
Scale option A-5, A-9
separations, printing A-3
‘showpage’ after EPS files option 4-6
simulations A-2
Slip Sheet option A-5
Solaris 2 3-3
Solid Color rendering style A-4
Sorter option A-5, A-9
Stapler option A-5, A-9
Status WebTool, see WebTools
SunOS 4 3-3
Suspend Printing command A-3, A-5
SWOP-Coated simulation A-6

T
TCP/IP printing 3-1
thick paper A-3
Top-Bottom A-7
Top-Top A-7
transparency A-3
trays, printer A-4, A-8
troubleshooting

color output C-4
Downloader C-5 to C-6
general printing problems C-2 to C-3
problems with print quality C-4 to C-5

U
UNIX

BSD (Berkeley Software Distribution) 
variant of 3-3
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displaying jobs in queue with 3-2
printing from 3-1 to 3-3
removing jobs from queue with 3-3
System V 3-3

user software xiii

W
WebLink,  see WebTools
WebSpooler, seeWebTools
WebTools

accessing xiv, 5-1, 5-2
home page 5-2
problems with C-6
Status 5-1, 5-2
WebLink 5-2
WebSpooler 1-8, 1-11, 2-9, 5-1, A-1

White Point option A-4, A-8
Windows 3.1x

PostScript printer driver 1-7 to 1-9
printing 1-6 to 1-9
print options 1-6 to 1-9

Windows 95
PostScript printer driver 1-1 to 1-5
printing 1-1 to 1-6
print options 1-1 to 1-6

Windows NT 4.0
PostScript printer driver 1-10 to 1-12
printing 1-1, 1-10 to 1-12
print options 1-11 to 1-12

WINS printing 1-1
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